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Splitting columns

Often there is a need to break down data to make it easier to work with. For example, if you want to sort
people in alphabetical order using their surname you will need to make sure their name is split into first
name & surname columns.

Tip: Create a column to the right of the column you wish to split for the results.

Music Mentors data with notes - Excel Table Tools Alice Linell =

1. Click on the
Data tab

Review View Help Design 2 Tell me what you want to do

* [ Queries & Connections | & [Z]A W [F B #E Group ~
3 o 2 2 B 3 B
& Qe ctions ' i o - 28 Ungroup
Get Refresh zl Sort Filter Textto _ & What-f Forecast
Data ~ B . . All~ Vo Advance Columns =~ & Analysis - Sheet
2. Highlight the
CQueries & Connections Sort & Filter Data Tools Forecast Outline

column to split

Bl Text to Columns

Split a single column of text into
multiple columns. M

3. Click on the Text

1 H -
2 1|Wolfgang Puck to COIUmnS 3 For example, you can separate a
3 2|Julie Walters HMP Bronzef command button ] :_olumndolf full names |‘nto separate
4 3|Margaret Atwood|HMP Bronzef i irst and last name columns.
5 4|Usain Bolt HMP Manchester 00 DU vou can choose how to split it up:
6 5|Alain Prost HMP Manchester 26459 GU fixed width or split at each comma,
7 6|Andre Agassi HMP Swansea 20924 GU periad, or other character.
8 7|Harper Lee HMP Bronzefield 20706 (
El Convert Text to Columns Wizard - Step 1 of 3 ERT=
10 The Text Wizard has determined that your data is Delimited, S 4 The con\lel"t Table to
If this is corredt, choose Next, or choose the data type that best describes your data. . .
Original data type Columns wizard will open
Choose the file type that best describes your data:
@) Delimited - Characters such as commas or tabs separate each field. K
() Fixed width - Fi

ligned in columns with spaces between each field.

Preview of selected data:

/

Elorn Donerme 3 ..
313“;12:; i 5. Select Delimited & then
2frine Hees = click on Next

A Delimiter is a blank space, comma, or other character or symbol that indicates the beginning or end of
a character string, word, or data item

Convert Text to Columns Wizard - Step 2 of 3 @

This screen lets you set the delimiters your data contains, You can see how your text is affected
in the preview below,

Delimiters \

6. Select what delimiter to use to

Semical | Treat consecutive delimiters as one . .
E;ﬁ':am separate the data into columns. In this

- Text gualifier: |~ |7| oy o
V] Space  ee—— example the data to split is separated
[ otner: — by a space )
Data preview l

4 N
fate |fmite 7. The wizard displays how
S — the text will be split
[Colin  [Cregan I 4
Hine Htet | -
4 13
cancel | [ <Back | [ Nea> | [ Finisn |




Convert Text to Columns Wizard - Step 3 of 3 ? x (
8

J

This screen lets you select each column and set the Data Format. . SeIect the data format for eaCh
Column data format — column. General automatically
Ob ‘General’ converts numeric values to numbers, date values converts the COlumn to the most
O Text to dates, and all remaining values to text. a ro riate format YOU can
() Date: | DMY ~ Advanced... PP _p ’
©) Do not import column (skip) override that now or later after

o the split

Destination: | $B51 +

Data preview
~
Y]

Cancel < Back MNext >

Merging columns together (CONCAT)

Excel has a built in function to merge text strings together. For example, if you have a first name column and
a last name column but you want a Full name column where first and last name are joined together.

The function, when using a table, is as follows:

=CONCAT(Tablename[@[tablecolumnnamel]:[tablecolumnname2]])

But Excel can build the formula for you:

1. Add an extra column in your table to the right of the two columns you are merging
2. Enter the =sign and start typing CONCAT
3. Select the CONCAT function suggested by Excel
4. Select the first cell in the 2 columns you want to join together.
AutoSave B9~ TEST ATTENDEE data Excel Bitesize 2 - Creating a workable data set (1) s - Saved ~ pel Alice Linell (AL
File Home Insert Page Layout Formulas % Review View Help Table Design 12 Share 1 Comm|
= [ [& | 1Al Y4 =g 4 & I
& 2 B m ooy s YT 2% 3 [
utline
== B al % & v
Get & Transform Data Queries & Connections Data Types Sort & Filter Data Tools Forecast
- X v L =CONCAT(Y2Participants[@[Postcode]:[Postcode 2]]‘
A B CONCAT(text1, ..) D H & G H
1 -Name Prison _Postcude -I’nstcode 2 -I’ostcode 3 Categury Welfare sessionl’ri
2 1 Prince Charming HMP Belmarsh SE28 OEB 1=CONCAT(Y2Participants[@[Postcode]:[Postcode 2]] HMP
3 2 Boy George HMP Belmarsh 1R x 2C SE28 OEB A Y HMP
4 3 Road Runner HMP Belmarsh SE28 OEB A Y HMP
5 4 Donald Duck HMP Belmarsh SE28 OEB A Y HMP
6 5 Mickey Mouse HMP Belmarsh SE28 OEB A Y HMP
7 6 Ali Baba HMP Brixton SW2 SXF A Y HMP
8 7 Wiley Coyote HMP Brixton SW2 SXF A Y HMP
9 8 Butch Cassidy HMP Brixton SW2 S5XF A Y HMP

If you want to add a space between the text you will need to use a slightly different technique:

5. Add an extra column in your table to the right of the two columns you are merging
6. Enter the =sign and start typing CONCAT
7. Select the CONCAT function suggested by Excel
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8. Select the first cell you want to join, then add to the formula,” “, and then select the next cell you want

to join together. See the screen print below.

=CONCAT([@tablecolumnnamel]," ", [@ tablecolumnname?2])

AutoSave B9~ TEST ATTENDEE data Excel Bitesize 2 - Creating a workable data set (1) s* - Saved ~ o] Alice Linell AL

File Home Insert Page Layout Formulas Data Review View Help Table Design I Commer|

~= I M, O m Y =g & s 77 | a8

Bl & B @ oy - o VI s u BB

= = . Outline
=2 m 4 S = v
Get & Transform Data Queries & Connections Data Types Sort & Filter Data Tools Forecast
E2 - X « fr  =CONCAT([@Postcode]," ",|@Postcode2])|
A B C D E F G H |

Ll Columnl B Name B Prison B Postcode B Postcode2 B Postcode3 B Category Bl Welfare session Bl Pri
2 1 Prince Charming  HMP Belmarsh SE28 OEB [@Postcode2]) A Y HMP
3 2 Boy George HMP Belmarsh SE28 OEB SE280EB A Y HMP
4 3 Road Runner HMP Belmarsh SE28 OEB SE280EB A Y HMP
5 4 Donald Duck HMP Belmarsh SE28 OEB SE280EB A Y HMP
6 5 Mickey Mouse HMP Belmarsh SE28 OEB SE280EB A Y HMP
7 6 Ali Baba HMP Brixton SW2 SXF SW25XF A Y HMP
8 7 Wiley Coyote HMP Brixton SW2 SXF SW25XF A Y HMP
9 8 Butch Cassidy HMP Brixton SW2 SXF SW25XF A Y HMP
10 9 Robin Hood HMP Brixton SW2 SXF SW25XF A Y HMP

Data Validation

The Data Validation feature in Microsoft Excel controls what can be input into a cell to ensure accurate and
consistent data. Here we’re

1. Ensure Correct data format
2. Limit data entry options to a list

Data Validation for data format

Music Mentors data with notes - Excel

B - Table Tools

File Home Insert Page Layout Formulas Review  View Help Design  Tell me what you want to do

£ Queries & Connections Y ] E E —
T2 e 5 B RSN 8= =5 @
Refresh il Sort Filter Textto Flash Remove Data  Consolidate Relationships  Manage i
1 CI k th D tat b s AllT Vo advanced | Columns  Fill  Duplicates Vajidation ~ Data Model  An
* Ickon € ata ta Queries & Connections Sort & Filter Data Validation...

= = Circlg”" o

E2 = = (1ey Dita Validation
=3 T

A B C D E F H I Pick from a list of rules to limit the
1 [ ™ Name ~ M Date of b M Gende - - - e e type of data that can be entered in
2 1 Wolfgang Puck  HMP Pentonvil 22081 acell
3 | 2lulle Walters HME 23625 / For example, you can provide a list
4 27742 / of values, like 1, 2, and 3, or only
5 36015 é allow numbers greater than 1000
6 2' SeleCt the COIumn 26459 I k h || acvalid entrles.g
; . 2004 3. Click on the Data B
5 tO Valldate 20706 . . B e Tell me more

Validation command button
9 26103 6 Hone Heke
L




Data Validation 7 s F

Input Message  Error Alert

Validation criteria data is allowed

Allow:

1. Specify what type of

Date o lgnare blank

Data:

greater than or equal to |~

method

2. Chose validation

Start date:

01,/01/1980

%

3. Define parameters

|:| Apply these changes to all other cells with the same settings

Clear All Cancel
Jate of birth Bl G Mlicrosoft Excel s
\ Ba
e This value doesn't match the data validation restrictions defined for this cell, B4
Dr
Cancel Help D
05/04/2003 Gy
4. An error message will appear if data \ 21/03/2003 Gy

outside of the parameters is entered. Here
the vear doesn’t meet the requirement of

Data Validation with list options

Data Validation ? >

settings  |nput Message  Error Alert

Validation criteria

1. Follow the steps as above to

access the data validation options
\

Allow:

List » lgnore blank

Data: ropdown

petween s 2. Select List
Source:

Male, Female, Other, Not given| .

NS

Apply these changes to all other cells with the same settings

3. Enter the data entry list with
each item separated by commas

Clear All Cancel




_ ) pata TS ) ) e 4. Click the drop down arrow and

o ome . a
- a selection list drops down for
o A )
Queries & Connections 4 H

Bl B b B 2 data entry

Get From  From From Table/ Recent Existing Refresh zl Sort
Data = Text/CSV  Web Range  Sources Connections  All~ =

Get & Transform Data Queries & Connections Sort
E2 & Jx
A B e D E H
1 - o ™ Priso M D of b - de - - - B To
2 1 Wolfgang Puck  HMP Pentonville 22081 - Bass
3 2 Julie Walters HMP Bronzefield 23625 EE'EI Bass, guitar
emale

4 3 Margaret Atwood HMP Bronzefield 27742| other Drums
5 4 Usain Bolt HMP Manchester 36015LMat given Drums
6 5 Alain Prost HMP Manchester 26459 Guitar
7 6 Andre Agassi HMP Swansea 20924 Guitar

An alternative to typing the list in is to use source data you already have. For that you’ll need to put the cell
references of where the data is into the Source field. Where this is in another sheet — just move to this sheet
and select the Column containing the list of options you want displayed.

Data Validation ? X

Input Message  Error Alert

Validation criteria

Allow:

List ~ Ignore blank
Data: In-cell dropdown
between ~

Source:

="Instrumeny list'!$AS 1:3A517

[

] Apply these changes to all other cells with the same settings

Clear All Cancel




Make your data into a table

Page Layout Formulas Data Review View Help Q Tell me what you want to do

1. Click on the H Get Add-ins E 1?
PivotTable Regs Oed Table Pictures inine Insert tab 3 My Add-ins ~ Bing People Recommende
Pictures Maps Graph Charts
2. Click on the Ilustrations Add-ins
Table command Table (Ctrl+T)
button Create a table to organize and
analyze related data.
A | Tables make it easy to sort, filter, D E | F | G
1 |Name Y and format data within a sheet. genow Date registered Age at registration Instrument experience
2 |Alain Prost @ Tell me more 05/04/2003 Guitar
3 |Alia Bhatt S R 09/09/2016
4 |Andre Agassi HMP Swansea 14/12/1975 21/03/2003 Guitar
— Alternative shortcut: Ctrl + T
Create Table ? *
Where is the data for your table? <
=5451:5N552| + 3. A window will open.

Confirm the cells to be
included in the table and that

Cancel the data has headers

My table has headers

Name the table

It is good practice to name the table as it makes life much easier later when working with formulas. Naming
the formula is basically giving your data set a name which will enable you to recognise which data set you
need to be working with.

Music Mentors data with notes - Excel

File Home Insert Pagelayout Formulas Data Review View Help [JSCcre

1. Click on the table & select
the Design tab

rable Name: Summarize with PivotTable D Header Row ] First Column
> [k

otal Row [ ] Last Column

Banded Rows [ | Banded Columns

[rablez B Remove Duplicates

Insert ~ Export Refresh
Slicer 2 2

D Resize Table

Properties External Table Data Table Style Options BEEETE

2. Rename the table. For
example, “BookingData”




Pivot Tables

Creating a pivot table

AutoSave EI:SH “)v Q’v =

Music Mentors data with notes.xlsx 88 - Saving...

File Home Insert Pview View Help Table Design
1. Click on the Insert tab

E[=] E=]| ? EI]] v I:E v nﬂuu v @ E[==]

175 I - ey e 2 LD
PivotTableN8&&gommended lllustrations . Recommended \ Maps PivotChart

" . 6) My Add-ins ~ E Charts %D ~ |._ ~ v v
. i Add-ins Charts ]
2. Click on Pivot Table

Ref v | Date of birth ¥ | Gender - |Age now ¥ |Date r¢g
2 | aln Pros HMP Manchester 09/06/1972 47
3 | 2 Alia Bhatt HMP Holloway 02/02/1950 70
4 3 Andre Agassi HMP Swansea 14/04/1957 62
5 4 Ben Okri HMP Manchester 23/04/1984 35
| AutoSave : sx 8 £ Search

File Home Insert Page Layout Formulas Data .
9=y 2. Select the table you want to base the pivot table
Participants - f¢ | Dave Robson on. Here you can see the table name “Participants”.
ref [~ S —Prison ~IDate of birth Using a table ensures you have a dynamic data source
2 1 Alain Prost HMP Manchester o9/06/4 for your pivot table
3 2 Alia Bhatt HMP Holloway
4 3 Andre Agassi Hi . 21/03/2003 ’F'Iays a
5 4 Ben Okri Hy Create PivotTable < [ 09/09/2016 'No mu
6 5 Boris Becker H! Choose the data that you want to analyze L 27/02/2017 :Plays a
7 6|Dave Robson JHD ®) selecta table or range | 21/03/2008 No muy
8 7 David Attenboroug HN B o el = 17/08/1998 Plays a
- | ;| Participant + |

0 8 David Beckham  H) Table/Range: | FAAIOPAIE i 31/01/2008 Plays a
10 9 Diane Kruger HY O Usean extemal data source | 21/03/2003'No mu;
Ik 10 Diego Maradonna HH Choose Connection.. | 04/05/1999 "No muj
12 11 Dilip Kumar HA Connection name: | 23/07/2013 No mu|
13 12 Emma Barnett HN Use this workbook's Data Model | | 17/08/1998 "No mu
4 13 Emmanuel Macron H} ) 19/02/2004’No muy

5 | Choose where you wanit the PivotTable report to be pl v
15 14 Enid Blyton HR ® New Worksheet 3. Select New Worksheet 17/08/1998 'PIays a
16 15 Fiona Bruce Hy o e orenee g 30/09/1999 No mu|
7 16 Freya Crew fll O Eisting Worisheet | 04/05/1999'No mu;
8 17 Harper Lee HN Location: * 04/04/2009 'PIays a

| W L4
E 18 Hone Heke H! Choose whether you want to analyze multiple tables | 09/09/2016'”3\(5 a

L ;

PO 19 Jacina Ardern HA [ Add this data to the Data Model | 02/05/2000f|ays a
P1 20 Jack Tate HH | 05/04/2003 Plays a
p2 21 Jane Goodall HA Cancel | 04/05/1999 'PIays a
P3 22 Jason Robinson HNrr owansea ZIUUf IY0L o0 04/05/1999 'F'Iays a
P4 23 Joan Chen HMP Bronzefield 16/02/1970 18/02/1900 17/08/1998 No mul
P5 24 John Cleese HMP Pentonville 18/09/1963 25/02/1900 07/03/2011'No muj
P6 25 John Steinbeck HMP Pentonville 28/06/1969 50 21/03/2003 'F'Iays a
p7 26 Jonny Wilkinson ~ HMP Swansea 05/06/1985 03/02/1900 05/04/2003 "No muj

. . | 4

Particpants | Sheet1 | Attendance | Service feedback | Outcomes | (¥ 4




P search

4. An empty pivot
table is created

1

2

3

4

5 |
6 | To builda report, choose fields from the PivotTable Field List
7

8

Participants Attendance Service feedback Outcomes F 4 >

Sheet1

File ~ Home Insert Pagelayout Formulas Data Review View Help PivotTable Analyze Design
o t - 1 (i AutaSum ~
0 & cut Calibri Jin YA A | 2 WrapTex General - Bl @ @ o e é e
[®copy ~ Fill »
Paste Conditional Formatas Cell | Insert Delete Format
Iyu-~|MH- .|l m- o9 o0 o )
~ < Format Painter = - RIOES B-% 9 B Formatting ~ Table ~ Styles ~ - ~ ~ & Clear~
clipboard ] Font [ Aligm Styles cels Editing
A3 fi

PivotTable Fields
Choose fields to add to repart:
Search

[ Rer

[ Name

[ prison

[ Date of birth

[ Gender

[ Age now

[ Date registered

[J Musical experience
[ Instrument experience

Drag fields between areas below:

T Filters

Rows

Defer Layout Update

- Comments

1 Share
Find & | Ideas
Select >
Ideas sensitivity
Il Columns
X Values

Music Mentors data with notes & - Saving... =

nutosave @D B 9~ Alice Linell &

File m Insert  Page Layout Fo 3 Share
& e e .| 6.To create a simple pivot table that P BEE iy O 4
[copy ~ N . . eil Insert Delete Format Edrn- Find & | Ideas
Jemarme © 14 20 shows the number of prisoners attending == - - - ©ce select~
clipboard M Font . . cells Editing Ideas

- - 4+ w.] sessionsfrom each prison drag and drop

4 : the Prison field into the Rows box and L | M o otTable Fields

: e the Name field into Values Choose felds to add to report

4 ristol

b s\

6 | HMP Holloway 9 [ Ref

7 HMP Manchester 9 [¥] Name

8  HMP Pentonville 8 7 Prison

9 _|HMP Swansea ’ [ Date of birth

10 Grand Total a7 ] Gender
il [ Age now
12 ] Date registered
13 [ Musical experience
14
= [ Instrument experience
1? H . Drag fields between areas below:
" 7. The pivot table now displays how
T Filters W Columns

19 . .
20 many prisoners attended the music
21
22 sessions from each prison
25 Prison = | | Count of Name
26
27
28
29

Sheet1 | Participants | Attendance | Service feedback | Outcomes | (@) f y Defer Layout

8. As the name field is text the pivot table

assumes you want to Count the number of

records in the Name

1 Comments

Sensitivity

10




AutoSave B Y- -
File

Home Insert Pagelayout Formulas Data

Subtotals Grand Report  Blank
v Totalsv Layout v Rows v

[¥] Row Headers

Layout

D5 - S o4

|Count of Name  Column Labels =
Prisons

HMP Bronzefield
HMP Holloway

3 1
6

HMP Manchester 4 1
3
3

O~ bW

9 |HMP Pentonville
10 |HMP Swansea
11 |Grand Total 20 3

» Musical experience | Participants | Attendance

(] Banded Rows
[¥] Column Headers [] Banded Columns

PivotTable Style Options

Music Mentors data with notes &

Review View Help

Bouwvewn

£ Search

Alice Linell

PivotTable Analyze

- No musical experience Not recorded Plays a musical instrument Grand Total
HMP Bristol 1 4 5

~Nwmw oo

Design

PivotTable Styles

PivotTable Fields
Choose fields to add to report:
Search

[ Ref

[+ Name

[ Prison

[ Date of birth
[ Gender

9. Add complexity to your Pivot
table. To show how many of the
attendees from each prison
already had musical experience,
add the field Musical
kexperience to the Columns field

[ Age now
[ Date registered
[ Musical experience

[ Instrument experience

Drag fields between areas below

T Filters

Service feedback

Outcome: ...

Defer Layout Updaté

15 Share

Wl Columns

Musical experience -

¥ Values

Count of Name

7 Comments

Field values

File ~ Home Insert Pagelayout Formulas Data Review View Help PivotTable % Share (2 Comments
=1 B8 Online Pictures 3D Models ~ i 1 1 E: v
B ol Piures @ 30Models | By 1.Highlight the fields you want | &= T || ]| I semon
) Shapes > IR SmartArt () symbol
Pictures £ My Ad Recom| . Timeline Comment  Text
w5 Icons } Screenshot &I My Add-ins ~ tO dISp|ay as a percentage >
Tables lustrations iers Unks | Comments symbols A
B4 - ks v
| A B c IJIKILIMNIOPQR|[~- . .
] PivotTable Fields * X
2
| 5 B -
3 [orisons T T Choose fields to add to repart: &
4 |HMP Bristol i Calibri ~11 AT A ER- % 9 B gol
5 |HwmP Bronzefield | BIS 0w A-[-988
6 [HMP Holloway  } o [ Ref -
7 |HMP Manchester } -
8 [Hmp pentonville | & cony v
H No Caleulation
i
i
2 i s B fomatcets .ot Gt T 2. Select Show Values As and
11 |Grand Total Number Format.. % of Column Total [
2| then % of Grand Total
= [B Reresn % of Row Total
14| Sort > % Of..
15 =
H X Remove “Count of Name % of Parent Row Tatal
Drag fields between areas below:
17 Summarize Values By > % of Parent Column Total
18
19 Show Values As > % of Pargnt Total. ¥ Filters L E
i? +Z Show Details Difference From.
22| IR Value Field Settings. % Difference From.
23
= PivotTable Options. Running Total In. = Rows = Values
25| Bl vide Fieig List % Runing Total In Prison ~ || count of Name -
26| Rank Smallest to Largest...
27
2 Rank Largest to Smallest.
29 Index e
v Sheet2 | Sheet3 | Musical experience | Partic fe r v e
Select destination and press ENTER or chpose paste More Options.. sverape 7avnns conve sy DEEN WM - =

11



1]

Alice Linell

6 |HMP Holloway 19.1%)

7 HMP Manchester 19.1%
8 |HMP Pentonville 17.0%
9 HMP Swansea 14.9%
10 | (blank) 0.0%
11 Grand Total 100.00%
12
13
4
15
13

3. Percentages
replace the
original
numbers

place command button to
round numbers.

[ Date registered

[ Musical experience

17
18
19
20
21
22
23
24
25
26
27
28
29
Sheet3

Sheet2 Musical experience

Participants

Drag fields between areas below:

T Filters Wl Columns
= Rows T Values
Prison ~ ||| Count of Name

Defer Layout Update

B @

Attendance Service fe ...

File ~Home Inset Pagelayout Formulas Data Review View Help PivotTable Analyze Design 4 Share T Comments
Eas t .o | = - AutoSum ~
7 b o g aa|= o Ton | B B EEE iy O 4
P [ Copy ~ Fill ~
Paste = Conditional Formatas Cell  Insert Delete Format Sort& Find& | Ideas
. . &AL = . - @Y 0 o
v <F Format Painter ry & = B Merge & Center BB~ % 9 W38 | fomaning~ Tablev Stlesv v v & Clear~ Filter v Select
Ciipboard [ Font 5 Alignment & Number " Styes cells Editing deas | sensitivity -
86 fo | 19.1289361702128% ~
A B c D E F G H . )
7 PivotTable Fields - %
2 & -
3 Prisons - Countof Name
4 HMP Bristol 10.6% .
b Evommefild o1 4. Use the Decrease decimal b

Sorting & Filtering a pivot table

Simple sorting and filtering work exactly the same as elsewhere in Excel.

# HMP Manchester
¥ HMP Pentonville
¥ HMP Swansea

£ Search

File  Home Insert Pagelayout Formulas Data Review View Help PivotTable Analyze Design % Share
PivotTable Name: | Active Field: — = = o= Be] [ = El = =l m
Es & [ B B | 7 05 @ B B
PivotTable2 Count of Name < i
Insert  Insert Refresh Change Data | Clear Select Move | Fields, Items, Relationships | PivotChart Recommended | | Field  +/-  Field
[[@options ~ [[= Field Settings Slicer Timeline - Source ¥ - ~  PivotTable B Sets v PivotTables List Buttons Headers
PivotTable Active Field Group Filter Data Adions Calculations Tools Show
A3 fe | Countof Name
A B = D E F G H ! J K = - o
1 PivotTable Fields
2
Choose fields to 2dd t t:
3 |count of Name _|column Labels - e U
4 |Prisons * No musical experience Not recorded Plays a musical instrument Grand Total ch
2l sotatoz 1 4
z [ Ref
SonZio A
Al s [ Name
More Sort Options, [+ Prison
[ Date of birth
[ Gender
Label Filters [ Age now
Value Filters [J Date registered
[ Musical experience
[] Instrument experience
¥ (Select All)
v istol
HMP Bristol ) Drag fields between areas below:
| HMP Bronzefield .
1 Holowy Click next to the row or ¥ e |

column heading for sorting
and filtering options

= Rows I Values

Prison - Count of Name

27
28
29
» Musical experience | Participants | Attendance

Defer Layout Update

Service feedback | Outcome: ..

7 Comments

Musical experience
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Add a Slicer to a pivot table

P search
Fle Home Insert Pagelayout Formulas Data Review View Help PivofTable Analyze  Design &4 Share 12 Comments
PivotTable Name: | Active Field: .= |~ Group Selection E‘ =5 D Eb. =] L_|m: Dn:l [Ge=) F =£ L—‘m: ’:\u:. E EIJ;] @
PivotTable2 Prison | 4Bungroup "y = < g Ly I I 4 = Uy Ly
! = | = Insert Insert Refresh Change Data | Clear Select Move Fields, ltems, Relationships = PivotChart Recommended | | Field  +/-  Field
IE Options ~ Field Settings - i) Slicer Timeliny hd Source ~ v ~  PivotTable & Sets ¥ PivotTables List Buttons Headers
(=] &
PivotTable Active Field Group Filter Data Actions. Calculations Tools Show ~
AS v K HMP Bristol A
A B c 5] i i )
A_a 1. Click on Insert Slicer  |.itapie Fields S
2
" : -
F [ — — - sse fields to add to report: &
4 Prisons - No musical experience Mot recorded Plays a musical instrument Grand Total p
5 |HMP Bristol ) 1 4 5
6 HMP Bronzefield 3 1 5 9 -
7 HMP Holloway 6 3 9
8 HMP Manchester 4 1 4 L]
9 | HMP Pentonville 3 5 8 [ Date of birth
10 HMP Swansea 3 1 3 7 [ Gender
11 Grand Total 20 3 23 a7 D1 age now
E [ Date registered
Like Tables, Pivot Tables can be formatted.
£ Search
Fle Home Insert Pagelayout Formulas Data Review View Help PivotTable Analyze Design & Share  © Comments

Subtotals Grand Report  Blank

v Totalsv Layout~ Rows | |2 ColumnHedders [ Banded Columns === 1 CIle on the inOt table and
- .
then on the Design tab E

ble Style Options

D5 - £ | a

PivotTable Fields T
Choose fields to add to report: &~
Search e

L] Ret -
[ Name
[ Prison

Count of Name  Column Labels
Prisons - No musical experien:
HMP Bristol

HMP Bronzefield
HMP Holloway
HMP Manchester
HMP Pentanville
10 |HMP Swansea

11 Grand Total
12
13
14
15
6
7
8
19
20
21

1

o~ s W N

@

3. Change the format (colours,
banding, outline etc) mernce

ot experience -

Drag fields between areas below:

T Filters W' Columns

2. Add and remove specific headers 5
or banding for rows & columns
23

= ¥
24 Rows Values

25 Prison ~ | || count of Neme -
26

27

28 Activate Windows

29 ings to activate Window

v Musical experience | Participants | Attendance | Service feedback | Outcome: .. prlem Lkl
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Refreshing data in a Pivot table

If you make changes to the data set being used to the pivot table, you might need to refresh the chart so
that the changes are immediately reflected in the chart.

AutoSave @ [E.“a z) v Ql v ¥ Music Mentors data with notes &% - Saved - P search -|

File Home Insert Page Layout Formulas Data Review View Help PivotTable Analyze Design

PivotTable Name: | Active Field: = - @ Il?'? _[% lﬁ%l lﬁ‘ lﬁ—il lﬁ!

i 2]
PivotTable2 Count of Name — . Insert  Insert bnge Data Clear Select Move Fields, ltems,
@ Options  ~ @ Field Settings - ird| Slicer Timeline ource v @ ¥  PivotTable & Sets v
PivotTable Active Field Group Filter #ta Actions Caly
B6 - Je 19.1489361702128%
A B C | D | E | F | G | H | |J KILIMNO P
1 —
2 —
3 _Prisnns. * Countof chlipri o111 o« A A g % 9
4 |HMP Bristol B I=0 A
5 |HMP Bronzefield -
6 |HMP Holloway 10%
7 |HMP Manchester (& copy
8 |HMP Pentonville El Format Cells..
9 |HMP Swansea
10 |(blank) Number Format..
11 |Grand Total {
. [E} Refresh
12 |
73_ Sort ’
14 |
15 > Remouye "Count of Name”
lg— Summarize Values By >
‘\8_ Show Values As >
19 *= Show Detail
20| = Show Details
21, ﬁ; Value Field Settings...
22
23: PivotTable Options...
24| Hide Field List
25|
26

Recommended Pivot Tables

A short cut to creating pivot tables can be to use the recommended Pivot table function.

AutoSave B = Music Mentors data for Excel Sorting & Analys... &% - Saved P search Alice Linell &

15 Share - Comments

Page layout Formulas Data Review View Help

+] B Online Pictures €2 3D Models ~ Ty D]'? g: E: Q: @ ’m dn@ E Iﬂ E E' @ (a) ﬁ/—:‘ 4 T Equation ~

§ L] I shapes * I SmartArt i i = - _ () symbol
Pictures My Addins ~ | Recommended ! Maps PivotChart | 3D Line Column Win/ | Slicer Timeline ~ Link | Comment | Text
) Icons t1} Screenshot ~ 6. My Add-ins Chars @~ L+ > - Map~ e %) ~
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Changing value field settings

In pivot tables you can select different types of setting for the values portion of your Pivot table. You can:

e Give the value set a custom (display) name
e Specify how you want to summarise values
e Specify how you want to display values

Trainer - Data Essentials training data xsx &

AutcSave D BY-Q-8- =

- Saved

File H0£ Insert Draw Page L = L L — = = o e WotTable Analyze
- . . nsert ~ Z e

.?D g, Calibr - '*&“ A 1. Right mouse click on the Value eg wete < | [~
e U~ FH~ v . .
e BTUYE Sum of Client ID and select the option ™" ¢~
Clipboard i Font . . Cells

- = S Value Field Settings

A B (5 =4 = - L

1

2

3 |Row Labels - |Sum of Client ID

4 #2019 3003

5 #2020 1183

6 Grand Total 4186

7

8

9

10

1

12

13

14

15

16

17

18

19

20

21

e ... Organisation - Pivot | Sheet9 | BookingData | Session Guidelines ® 4

Alice Linell AL lca] = X
Design % Share {1 Comments
APORE 4 Q

Find & | Ideas Share Webex
Select v This File  ~
Editing Ideas Sensitivity Webex ~
v
PivotTable Fields X%
Choose fields to add to report: & -
Search Je
[4] Client ID
[ Job Title

[ organisation

@g fields between areas be V' Move to Report Filter
ll Move to Row Labels

Move to Column Labels

X Remove Field

= Rows [ Vvalue Field Settings..
Years =~ * |'Sum of Client ID hd
Quarters M

Defer Layout Update

Custom value name

O Ssearch

File Home Insert Draw Page Layout Formulas Data Review View Help Power,
Ijj X [ conditional Fon
. 2, O fiZ Format as Table
paste LB 2. A- |sc===g. | B.%0 |E
. S jns = 8 fiZZ cell Styles ~

Clipboard & Font Alignment Number Styles

B3 g S Sum of Client ID
A B C D 2 F G H |
1 T
2
3 |Row Labels - |Sum of Client ID |
4 =2019 3003 Value Field Settings
5 #2020 1183 : .
6 Grand Total 4186
7 Custom Name:  Sum of Client ID I
8 Summarize Values By | Show Values As
10 Summarize value field by
11 Choose the type of calculation that you want to use to summarize
12 data from the selected field
B BT
Count
4 Average
15 Max
Min

1= Product =
17
18
1 rerr— o
20

4 ... | Organisation - Pivot = Sheet9 BookingData | Session Guidelines ® 4

Type in the name you would like to
use for the value field.

~
PivotTable Fields A
Choose fields o add to report: &~
Search 2
Client ID A
[ Job Title
[ Organisation -
Drag fields between areas below:

T Filters Il Columns

= Rows 2 Values

Years ¥ = SumofClientID v

Quarters ~

Defer Layout Update

15




Summarise values by

,O Search

Fle  Home Inset Draw  Pagelayout  Formulas Data  Review View Help  PowerPivot  PivotTable Analyze  Design B Comments

< A onditional Formatting Hinsert ~ v 1

[ M| == - SR 4 Q [

Paste Eg B T o A — === Find& | Ideas Share Webex

& i - . Select v This File

Clipboard & Font Alignment 1 SeIeCt the tab Summarlse Va|ueS a9 Ideas Sensitivity Webex ~
B3 - fr | Sum of ClientID Bv

1 e ——— i : i /I ' ¢ : ** PivotTable Fields v %
2 o - -
37 Row Labels| - ]@l Choose fields to add to report: @
4 =2019 3003 Value Field Settings, ? x Search p
5 #2020 1183 Source Name: Cli

6 Grand Total 4186 et Ko oo a
: N ' 2. Select how you want your field

| Summerize Vabues By |{gSboeleshs . -

190 Summarize value field by summarised
h1 Choose the type of calculation that you want to use to summarize
h2 data from the selected field T Filters 1l Columns
s e ——
14 AS:r:ge
ns Max

6 Min
:7 Erodud he = Rows S
8 Years * |* | Sumof Client ID -
& jumber Format v
bo Number F Quarters -
P1
[ ... | Organisation - Pivot = Sheet9 BookingData | Session Guidelines ® . » Pl ki
Most common calculations used to summarise data:

Function Summarizes \
Sum The sum of the values adds all the values in the selected data range. This is the default

function for numeric values.
Count The number of values. The Count summary function works the same as the COUNTA
worksheet function. Count is the default function for values other than numbers.
Average The average of the values. The average is the mean average of the numbers. To

calculate: Excel adds up all the numbers, then divides by how many numbers there
are. In other words it is the sum divided by the count.

Max The largest value.
Min The smallest value.
Product The product of the values. The product is the result of multiplying the numbers eg the

product of 2 and 3 is 6.
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Show values As

,0 Search
File Home Insert Draw Page Layout Formulas Data Review View Help Power Pivot PivotTable Analyze Design J Comments
on ¥ 5 § [ conditional Formatting v EHinsert ~ >~
> 4y Q
BB~ % 9 [Eromatas Table - BZ Delete ~
= — = Sort& Find & | Ideas Share Webex
1. Select the tab Show Values As %8 FB2 cell styles ~ ElFormat~ | & Fiter~ select+ ThisFie v
Number Styles Cells Editing Ideas Sensitivity Webex ~
A B c G H 1 J K L M ~ [ .
7 PivotTable Fields v X
2
Choose fields to add to report: &~
3 Rowlabels - Client ID ? X
4 | #2019 [:M'ﬂ%. | Source Name: Client Search 2
5 #2020 15.38%
6 (GrandTotal ~ 100.00% T ETE |l [ Client ID -
] Summarize Values By | Show Values As | [ Job Title
o
g | Show values as . -
o o — 2. Select how you want to display the
l; Base field Base itemn: data
{ ns
13 neeeds
14
15 | |
16 | vears ] |
17 = Rows % Values
18] Iumber Format concel | | Years ~ |2]| dlientiD ¥
19
20' Quarters 5 |
21
W . | Organisation - Pivot | Sheet9 = BookingData | Session Guidelines ® « y Defer Layout Update

Most common ways of displaying data:

Use this

calculation

No calculation  Turn off custom calculation.

% of Column Display all the values in each column or series as a percentage of the total for
Total the column or series.

% of Row Total Display the value in each row or category as a percentage of the total for the
row or category.

Rank smallest Display the rank of selected values in a specific field, listing the smallest item in

to largest the field as 1, and each larger value with a higher rank value. Create a new
column for Rank if you want to show the specific amounts too.

Rank largest to Display the rank of selected values in a specific field, listing the largest item in

smallest the field as 1, and each smaller value with a higher rank value. Create a new
column for Rank if you want to show the specific amounts too.
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Changing the sort order

DataEssentialsALLDATA-02Mar2020 - Excel

Design

PivotTable Tools

Q Tell me w

:

oo Conditional Forr

Ta
Style

Formatting -

ul

42

Insert Page Layout Formulas Data Review View Help Analyze
- (x) . . o
D Calibri A A= 2 Wrap Text General
g -
Pafte I u- - DA === E3E= EMergefiCenter - - % 2 G0
Clipboard = Fant I Alignment F Number
B10 & 5 || 29
1.Right mouse click on a
A B C . | H | 1
; value in the data set you
2 | want to sort
3 |Row Labels -T|Count of Customer ID
4 |Email 19
3 |Internet 1
& |Internet search Heard via?
7 |Newsletter Calibri - 11 - g‘ L]
8 |Twitter =
- B I = &~ -
8 |Unknown — -
10| word of Mouth . ~nl Unknown 2. Select sort and the sort
E% gopw .
11 Grand Total ! order you require
12 :=| Format Cells...
13 | MNumber Format...
14_ Ef," Refresh
15
16 | Sort » | 2| Sort Smallest to Largest
17_ 7< Remove "Count of Customer ID" El Sort Largest to Smallest
18_ Summarize Values By r More Sort Options...
19— Show Values As 3
20 N
21: *=  Show Details
22 | [ Vslue Field Settings.. More sort options allows
23 ions . . g
- : PivotTsble Options... you to input a specific sort
a0 DE SH Client BE Hide Field List

Dazrs

order
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Custom sort order

Go to File > Options > Advanced

Excel Options

General
Formulas
Data
Proofing
Save
Language

Ease of Acce

Customize Ribbon

Quick Access Toolbar
Add-ins

Trust Center

Cluster type: -

When calculating this workbook: ﬂOnIine Feedback A.. =

Update links to other decuments
[ Set precision as displayed
[] Use 1904 date system

Save external link values

General

[] Ignore other applications that use Dynamic Data Exchange (DDE)
Ask to update automatic links

[] Show add-in user interface errors

Scale content for A4 or 8.5 x 11" paper sizes
At startup, open all files in:

Enable multi-threaded processing

Create lists for use in sorts and fill sequences: | Edit Custom Lists...

Lotus compatibility

Microsoft Excel menu key: |/

|:| Transition navigation keys

Lotus compatibility Settings for: ﬁ Sheetl -

[1 Transition formula evaluation

[ Transition formula entry

1. Select the option Edit
Custom Lists

oK I | Cancel

Custom Lists

Custom Lists

Custom lists:

List entries:

Mon, Tue, Wed, Thu, Fri, Sat, &
Monday, Tuesday, Wednesday
Jan, Feb, Mar, Apr, May, Jun, I
January, February, March, Apri

Pres
Imp
commas.

| love this idea, This is an OK Add
idea, | don't think this is a

good idea, Mot sure| Delete

4. Add your custom sort
order separated by

]

Import

Cancel

\

3. Click on Add

2. Click on OK
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Grouping dates

In Excel 2016 and later versions, Excel automatically groups dates by months & quarters. If you are working
with an Excel version prior to that or you want to change the automatic grouping you can manually group
dates.

Home Review View Help  An

¥ cut T Bx = autosum - QA‘T p

# | Normal Bad

Calibri 1 Good Neutral T

E2 copy - . . - i z 3 Fill+

¢ rormruienr | = 7 7| B 2. Right mouse click on o CETIEI| ceck e [ ollowes vy, e e Fomat | L seta reda
AN % | a date value

A N o P Q R 5 T u v w LI

1 PivotTable Fields =
2 -
3 | Row Labels [~ | Count of Choase fields to add o report: o 9
4 Lis Grouping L Search 4
o 5ot T
& Nov = e [ Berough
7 Dee = Elsmrngae | 18aond ] Organisaion Service Defvery type
8 2000 32 Egnaing st | 270272020 H O Cox
S 5 . 1. Select the Grouping e
0 san 18 pr——r ] Venue
n Feb 14 Minutes H [ Training Location
12 Grand Total 100 i yOU requlre 1 Date
13 7] Sessian date
15 [ Heard from?
= mber of doy - L] Hesrd via?
17 [ Support / access neeeds
o e e el

Drag fields between aveas below:

DataEssentialsALLDATA-02Mar2020 - Excel Alice Linell

Home Insert Formulas Data Review View Help Analyze Design 2 Tell me what you want to do

Row Headers

Subtotals Grand  Report EBlank

Page Layout

["] Banded Rows

Column Headers [ ] Banded Columns | =

i Totals - Layout - Rows -
ivotTable Style Options PivotTable Styles Ll
D Do Not Show Subtotals
w
Show all Subtotals at Bottom of Group c J K = X .
. i PivotChart Fields ~ *
2. Click on the Pivot table
Show all Subtotals at Top of Group Choose fields to add to report: & -
pmer ID
Search yel
— [1 Post code *
7 | Brent Borough
] Bromley Country
El Cambridge [] Organisation Service Delivery type
0] Camden [ Course Type
11 City of London [ Course
12 | Croydon [ Venue
13 Ealing [] Training Location -
14 | Enfield
15 Hackney Drag fields between areas below:
16 Hammersmith & Fulham
1 T Filters Il Columns
17 | Harrow
18 | Havering
19 Highbury and lslington 1. Click Subtotals or Grand
20 | Hounslow
21| 1slington Totals to show or not = e > i
22|  Kingston
23| Lambeth show totals Er5) ol [EIEmEsc
24 | Lewisham Bowuegh T
25| Merton
26 National 1 -
« » DE Knowlege Sheetd DE SH Client DE Heard Via \_ w @ L] » Vil
Ready HH | LU0 1 + 1008
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Summary sheets

In a summary sheet you can display data held in various other sheets in your workbook to see alongside each
other. The data in the sheet will dynamically update if new data is added to the other sheets in question.

File Home Insert Page Layout Formulas Data Review View Help Acrobat
flj & Cut Arial <14 LA A == v EE;WrapText General - ﬁ % MNo
E@Cop}r =
Paste = = = 3= = - .0 .00 Conditional Formatas Me
I U~ e A = €= 3= — = ~ O «
~  <¥ Farmat Painter - - - - = = Merge&Center 8 % 9 W 3 Formatting ~  Table ~
Clipboard ] Font ] Alignment = Mumber ]

Fa - 2 ='Prison info'!F2

Prison Information

In the formula bar
you’ll see the
“name of the stcode Category Gender Supervisor Number of Mentors
sheet”! and the -
b8 0EB o \alRosenherg |
cell reference 1 Click in the cell you want ——— 5
E\W 18 4AS to bring data into and W
start by entering =
6 HMP Brixton SW2 5XF \ Jepak Patel
. HMP Bronzefield TW15 3JZ B Female Kathleen O'Leary
- HMP Eastwood Park GL12 8DB C Female K \
2 Now click on the sheet B
g HMP Foston Hall NG32 2LG C Female A holding the data, in this 1
, |HMP Manchester M60 9AH A Male case Prison info, and
] click in the cell with the -t
, |HMP Pentonville N7 8TT B Male number of mentors.
HMP Wormwood W12 0AN B Male Now click Enter. )
12 |Scrubs Ny
13
14 |* Participants who selected "Enjoyed" or "Really Enjoyed"
15 |** Participants who selected "Agree" or "Strongly Agree"
16
7 |
18 |

| Guidelines | Participants | Validation lists | Survey Results Attendance Prison info Summary sheet | Exercise 1 Exercise 2

You can then copy down the formula as usual.
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